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Introduction

A brief overview of the

Motif ESP

Operating Manual
CHAPTEHR 1

The Motif ESP Character Generator

This manual teaches all you need to know about the Motif ESP
Character Generator.

It has been designed in such a way as to get you up and running
as soon as possible and therefore assumes you have immediate
and direct access to the character generator itself and, in particu-
lar, to the set of TEACH FILES, the hands on teaching program
supplied with each Motif ESP.

Motif ESP is a dual plane, 32 bit single channel character
generator that uses standard Postscript Type 1 typefaces to
create textof any size and angle along sideand over colourlogos
and full screenimages. Images and logos can be created within
the Motif ESP using the graphics facilities provided or imported
from a variety of sources, including PC and Macintosh graphics
systems, the Aston Wallet Stills Store and Motif’s own optional
RGB or 601 inputs.

The Motif ESP features two display planes - A Static Display
Plane and a Dynamic Display Plane, only the latter of which can
be used fordynamic presentations such asroll, crawl, zip, reveal,
etc.

Normally the Dynamic Plane is displayed in front of the Static
Plane and this is how you would normally work, using the
Lower Display Plane for static full colour backgrounds. How-
ever, it is possible to change the priority of the two Display
Planes on a page by page basis.

If you choose the Lower Display Plane as your Dynamic Plane
you will be able to roll or crawl text, for example, under
whatever is displayed in the Upper (static) Display Plane.

A word of caution though, if you select a solid opaque back-
ground or a full screen image in the Upper Display Plane,
everything in the Lower Display Plane will be obscured. How-
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ever, full screen images with appropriate key signals can be used
very effectively for masking purposes.

Both Display Planes comprise five discrete sub planes, as shown

The five sub planes of in figure 1.1. These are, starting from the back:-

the two Display Planes
Base Colour.
The Base Colour covers the entire screen. It can be one of over 16

million colours or gradated. It can also be either opaque, semi-
transparant or completely transparent.

Images.
The Image plane can be used to display a full screen colour
image. Images can be imported either via the 3.5 inch floppy
.disk drive in the TIFF file format, the Syquest Disk Drive as a
Wallet file or the analogue or 601 digital grab options. The
opacity of an image will be controlled by its key signal if one is
present.

Shapes.
The Shapes plane is used to display opaque or semi-transparent
shapes created by the character generator itself, using the many
graphics tools provided.

Row Shapes.
Similar tothe Shapes plane above, except thatin thislayer shapes
can be linked to a particular row of text in the Text Plane. The
result of linking shapes to a row of text is that when the row of
text is moved the shape or shapes will move as well.

Text.
This is the plane you’ll be using most of the time as it is the one
in which all your text and logos are displayed and edited.

Following switch-on or logging in, the Top Display Plane is
automatically selected and designated the Dynamic Plane.

1.2 Chapter 1
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Switching on

Activating your

keyboard
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Getting Started

The mains on/off switch is located on the rear panel of the
character generator.

Toturn the character generator on press the mainson/off switch
from ‘O"to T'.

As soon as you switch the character generator on, the rear
extractor fan will start and a small LED on the front panel will
glow green. After a few seconds the LED will flash between
greenand orange whilst the necessary system software isloaded
from the hard disk, after which the LED will revert back to green.

Please note: The LED will flash between green and orange whenever
data is flowing to or from the hard disk memory.

The Motif will be ready for use around twenty seconds after
switching on.

After switch on, the first thing you have to do is activate your
keyboard by logging in.

Up to ten keyboards can be connected in series to the character
generator, but only one can be assigned control atany time. You
can only activate your keyboard if the ‘Please Log-in" message
dialogue box is being displayed on your edit monitor, as shown
in figure 1.2 below.

Welcome to Motif ESP
Please Log in

(Press any character key)
Software Version 3.2

Figure 1.2. The Log In dialogue box
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The Ctrl LED glows red when
the keyboard is selected

Status Rows On/off

Operating Manual

To activate your keyboard simply operate any alpha-numeric
key.

As soon as you have successfully ‘logged-in’, the LEDs in the
two control keys, either side of the space bar, will glow red and
the ‘Please Log in” message box will disappear. In its place will
appear the Edit Display as shown in figure 1.3.

Please note: After activating the keyboard the Motif automatically
goes into its character generator mode and selects the Top Display
Plane and designates it as the Dynamic Plane.

The Edit Display

Edit Fount Colour Dynamigs Plane File Software Utls

‘ Menu Selection Row
m iSa(e Title Area

Typical Message Box

Edit' Dynamic Overtype Calour 12 Foun;
Cuwrrent Page 23 Next Page 24 News Week

[Page and File Status Row| Active
Colour Box

Figure 1.3. The Edit Display

The Statusrows, as well as displayed menus, can be switched off
and back on again by operating the [SHIFT] key with the
[CLEAR]key. This function willbe found useful whenyouhave
to edit text which is hidden by one of the Status rows or a menu.

The cursor remains visible and the editing and disk functions are
still available whilst the Status Rows are switched off.

1.5
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The Safe Title Area

Menu Selection Row

Text Status Row

-

Page and File Status

Row

1.6
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The Edit Display comprises the following:-

The Safe Title Area, which occupies 80% of the screen, is repre-
sented by the large white rectangular outline. Although Codes
of Practice dictate that text and logos should be displayed inside
the Safe Title Area, it is possible to display text outside the Safe
Title Area if you wish.

The Menu Selection Row islocated just above the Safe Title Area.
Each menu, of which there are eight, is selected by either first
pointing with the Trackerball and operating either the
[ACCEPT] or [SELECT] key or by operating the control key with
the highlighted character of the menu heading. For example, to
select the Edit Menu you would operate the [Ctrl] key with the

|E] key. Headings within the drop down menus are selectec

with the [SELECT] key, not the [ACCEPT] key. However, when
selecting founts and colours from the side palettes you can use
the [SELECT] key or the [ACCEPT] key. Using the
[SELECT] key selects the fount or colour without removing the
palette. The [ACCEPT] key on the other hand, carries out the
selection but removes the palette from the screen at the same
time.

The Text Status Row, from left to right, shows you whether you
are editing the Static or Dynamic Display Plane, if you are in the
‘Insert’ or ‘Overtype’ mode, which colour number is selected,
which fount is selected, the height of the selected fount in TV
lines, and which dynamic mode is selected, for example roll,
crawl or static.

Please note: If you're working with shapes rather than textual
characters, the Text Status Row will display the word ’'Shapes’ (or ‘Row
Shapes’) in place of the word ‘Fount’.

The Page and File Status row, which is displayed at the bottom
of the screen, shows you the number of the page being displayed
as well as the number of the page which will be displayed when
the [NEXT] key is operated. It also displays the name of the
selected Page File.
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The Active Colour Box

Message Dialogue Box

The Preview Display

Operating Manual

The Active Colour Box is located in the bottom right hand corner
of the screen. It shows you the colour of the face, edge, block and
shadow of the selected character or colour. Italso provides you
with direct access to Motif’s unique and extremely versatile
ChromaBall.

As and when necessary, messages are presented in what are
known as ‘dialogue boxes’. The first message you will see after
switching on or after the ‘active’ keyboard has been ‘logged-oft’,
is the one shown in figure 1.2., requesting you to ‘Log-in’.

A 'picture-in-picture’ preview of the next page is displayed
towards the top left hand comer of the Edit Display. The
Preview Display can be set to come up after a page number has
been entered or page hasbeenrecalled fromdisk and displayed.
Alternatively, it can be set to come up only when the [PRE-
VIEW] key is operated. Either way, the Preview Display will
disappear as soon as any QWERTY key is operated or the
Trackerball is touched.

Edit Fount Colour Dynamics Plane File Software Utls

Page Number: 2034
ndry

Picture-in-picture
preview display

Edit: Suatic Overtype Colour 12 Fount 3 48 Lines  Static
pe 23 Next Page 24 News Week

Figure 1.4. The picture-in-picture preview display
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The number of the keyboard which has control of the character

Keyboard Number generator is shown just to the right of the Active Colour Box.

The 'Working' symbol appears in the top righthand corner of the
screen whenever the character generator is processing a new
character or recalling display founts and pages from the hard
disk memory.

The 'Working' symbol

Selecting Functions

Throughout this manual you will see instructions like “Select
Row Priority from the Edit Menu” or “Point and Select Directo-
ries from the Utils Menu”. So, the first thing you must learn is
how to carry out such instructions.

Justabove the Safe Title Areais the Menu Selection Row contain-
ing the names of eight drop down menus and palettes. Thereare
two ways to select a menu or palette, namely ‘point and select’ or
‘hot key’.

To ‘point and select’ you need to first operate the Trackerball
unti] the Arrow Cursor is positioned over the menu you want
(the menu will highlight with a green background when the
Arrow Cursor is positioned correctly) and then operate the
[SELECT] key. You'll find the [SELECT] key just above the
Trackerball. After operating the [SELECT] key, use the Tracker-
ball to scroll up and down the drop down menu or fount and
colour palettes. Operate the [SELECT] key to make a selection.

Point and Select

To 'hotkey’ you need to first take a look at the name of the menu
or function you want to select in order to see which character
is coloured blue, (in the case of ‘Edit’ it is the letter ‘E’). Then,
press and hold down the [Ctrl] key and operate the appropriate
QWERTY key. For example, to select the Utils Menu you would
operate the [Ctrl] key with the [U] key.

Hot Keying

As an exercise we'll have a go at Logging Off.

1.8 Chapter 1
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Logging Off

Logging Off can only be carried out from the active or selected
keyboard.

To Log Off you need to select Log Off from the File Menu, as
shown in figure 1.5 below.

The quickest way to do this is to use the ‘hot key’ method
described on page 1.8, (press and hold down the [Ctrl] key and
operate the [i] key followed by the [L] key). Try this and then
operate any alpha-numeric key to log on again.

Also have a go at using the 'point and select’ method with the
Trackerball and the [SELECT] key todetermine which of the two
ways of selection suits you best.

A word of caution: If you're editing or composing a caption, don t
forget to store it away before logging off.

File

Character Attributes
Page Files

User Accounts
Setup Palettes

Cursor Position
ASCII Text File
Log Off

Figure 1.5. The Log Off command
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The
TEACH
FILE

Chapter 1

The ‘TEACH FILE’

Included with your Motif is a self teach program called TEACH
FILE.

“TEACH FILE’ contains pages that have been designed to help
you become a competent Motif operator as quickly as possible.
Itis a hands-on teaching aid which takes you from the basics of
cursor control through to composing complex static and dy-
namic pages, such as reveals, zips, rolls and crawls.

Throughout the manual you will see the ‘teacher’logo, as shown
on the left, together with a page number displayed on the
blackboard. The page number tells you the page in the TEACH
FILE that relates to the text you are reading.

However, before selecting TEACH FILE, here are a few words
about how captions and Page Files are stored in Motif’s hard
disk memory.

Pages are grouped together into Page Files, each of which can
hold up to 9,999 pages. Page Files, in turn, are held in User
Accounts.

The number of Page Files and User Accounts is restricted only
by the amount of memory available on the internal hard disk.

If you're operating a new Motif for the first time, a page file
called ‘Default Page File’ from within a User Account named
‘STARTER'’ is automatically selected. If you take a look at the
bottomrighthand corner of the Edit Display you’ll see the words
‘Default Page File’ in the Page and File Status Row. A 'Default
Page File’ is the Page File that is automatically selected when-
ever you activate your keyboard by Logging On. Later on we'll
show you how you caninstruct the Motif to select automatically
one of your Page Files as the ‘Default Page File'.

Page Files, including "TEACH FILE’, are selected from within
the File Menu.
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Selecting the TEACH
FILE

Operating Manual
To select 'TEACH FILE’ do the following:-

a)  Select Page Files from the File menu. This will display the
name of the selected Page File and a list of Page Files within the
selected User Account.

If this is the first time your Motif is being operated then all you
will see are two Page Files, namely "TEACH FILE’ and "TEACH
FILE 2.

b)  Move the Trackerball down until only the words TEACH
FILE are highlighted and then operate the [SELECT] key. This
will display the selected Page File, (TEACH FILE) at the top of
the menu.

c)  Operate the [ACCEPT] key to change over to this Page
File. To remove the File menu from the Edit Display operate the
[QUIT] or [ACCEPT] key.

Take a look at the bottom right hand corner of the Edit Display
to confirm that “TEACH FILE’ has been correctly selected.

Change Page File

Page File - Default Page File

Default Page File

TEACH FILE 2

Figure 1.6. The Change Page File menu
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The Display Cursors

Thereare five different cursors used on Motif, although only one
of them is displayed ata time. All are instantly recognisable and
unambiguous in design. The five cursors are:-

The chequered cursor denotes that no base line has been set up
for text. You'll see it when the cursor is ‘floating’, rather than
sitting on a character baseline.

The solid cursor appears whenever it is correctly positioned on
an existing baseline.

The Outline Cursor appears whenever the cursor is correctly
positioned over an existing character, logo or space.

The Arrow cursor appears as soon as the Trackerball is operated.
It can be used to select a particular part of the screen, an
individual character, a menu from the Menu Selection Row’, as
well as founts and colours from the side palettes.

Similar to the Outline Cursor, the Area Cursor appears when-
ever the Shapes Plane is selected and is used to determine the
aspect ratio, angle and size of the next shape to be displayed. It
also appears when the area editing or area sizing functions are
being used.

The colour of the cursors (and edit markers) can be changed in
order to make them stand out more clearly. The colours avail-
able are white, yellow, magenta, red , cyan, green and blue.

To change the colour of the cursors operate the [COLOUR] key
with the [PREVIEW] key until the desired colour is displayed.

MMMt n
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Cursor Transparency

Cursor Position (X,Y co-
ordinates)

Teach File
pages3to8

Note: Cursor Home only works
when operated with a SHIFT

key

Operating Manual

Normally the cursor is opaque. However, it is possible to make
it semi-transparent in order to see text or graphics beneath it
more clearly. This will be found particularly useful when
working with the optional Image Editor.

Three levels of transparency are provided, plus opaque. To
change the level of transparency operate the [COLOUR] key
with the [CLEAR] key until the desired level of transparency (or
opaque) is displayed.

The X, Y co-ordinates of the cursor position can be displayed by
operating the [LETTER] key with the [HELP] key or by selecting
‘Cursor Position’ from the File menu, see figure 1.5. The co-
ordinate numbers within the displayed menu can be changed
using the number keys along the top of the QWERTY keyboard.
When the [ACCEPT] key is operated the cursor will move to the
new X,Y co-ordinate.

The Cursor Shift Keys

The cursor shift keys are located within the numeric keypad just
to the right of the QWERTY keyboard. The cursor canbe moved
left, right, up or down by operating the appropriate arrowed
keys.

The Cursor can be returned directly to the top left hand corner of
thescreen by operating the number 5 key (the key with the arrow
pointing towards the top left hand corner) with the Shift key.

I
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Select Key

Accept Key

Quit Key
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The Trackerball

The Trackerball enables you to move around the screen quickly
and accurately. The three keys above the Trackerball are used to
select functions and items from the drop down menus and fount

and colour select palettes.
As soon as the Trackerball is moved the Display Cursor will
change to the Arrow Cursor.

With the Arrow Cursor and the [SELECT] key you can select
characters and existing baselines, establish new baselines onany

scanline, select colours and display founts from the colour and
fount palettes, operate the 16 million plus colour ChromaBall,
and select menus and functions from the Menu Selection Row
and lower status rows.

The three keys above the Trackerball operate as follows:-

The [SELECT] key is used to select existing text and logos.
menus from the Menu Selection Row and to select items from
within each menu, as well as colours and founts from the side
palettes. It can also be used to select functions from within the
lower Status Rows, (change page file, fount height, etc.).

The [ACCEPT] key confirms the changes and selections you
have made. It can also be used to set new character and looo
baselines.

The [QUIT] key instructs the Motif to ignore the most recent
instruction.

Figure 1.7. The Trackerball Control
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Introduction

Aston 4 and Caption
Master Typefaces

Postscript Type 1
Typefaces

Operating Manual
CHAPTETR 2

In Chapter 2 you’ll get to understand the difference between a
Master Typeface and a Display Fount; the different types of
Master Typefaces used by the Motif ESP and how to obtain
them; how to select Display Founts when composing captions
and how to create new Display Founts.

Master Typefaces

Your Motif character generator is supplied with five Master
Typefaces, each of which describes a particular type style in
great detail. Master Typefaces are never displayed but are used
by Motif to generate Display Founts.

There arebasically two types or formats of Master Typeface that
can be used within the Motif.

The firstis the same format used by the Aston Captionand Aston
4 character generators. This type of Master Typeface uses ‘bit
map’ techniques to describe the shape and weight of each
Display Fount.

The second, and by far the best, is the outline format. This type
of Master Typeface is created by the Motif from the same
Postscript Type 1 typeface data used by the Apple Macintosh
computer, IBM PCs and clones.

To input a PC Postscript Type 1 typeface all you need to do is
insert the PC Postscript disk into the 3.5" floppy disk drive and
run Motif’s Typeface Importer program. Mac Postscript Type
1 typefaces can be imported via the optional Macintosh
FOUNTAIN typefaces utility program available from Aston.
Detailed information about installing Master Typefaces can be
found in Chapter 9, starting on page 9.1.

21
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)n Line character sizing

electing Founts

2 Chapter 2

Display Founts

Display Founts contain the actual characters that are displayec
on the screen. They can be any size from 6 TV lines to full screes
and the number of Display founts you can use on a page is, i

practical terms, unlimited.

Display characters are made as they are required and are auto-
matically stored on the large capacity hard disk for later use: but
only if the caption containing the new characters is stored as
well. If you decide not to store the caption, then all new
characters that are not additions to existing Display Founts are
removed from the hard disk and thrown away. This is done to
make sure that valuable space on the hard disk is not cluttared
up with unnecessary characters and logos.

However, all new characters produced by the Full Fount Proc-
essor are permanantly stored on the hard disk regardless of
whether or not they are used within a stored page.

The time it takes to process a character, assuming it doesn’t
already exist on the hard disk, depends upon the number o:
attributes you've chosen, its height and whether you've selectec
Guassian filtering or not. Typically, a plain character of, sav, 32
lines takes well under a second to process.

Display Founts areselected by either pointing with the Trackerbai.
at a display fount in the Fount Palette or by entering a fount
number. Either way, the first thing to dois to display the Foun:
Palette to see how many Display Founts are available.

There are two ways to display the Fount Palette. You canuse the
‘Point and Select’ method by positioning the arrow cursor over
the word 'FOUNT" at the top of the screen and operating the
[SELECT] key, or you can use the "Hot Key’ method by holding
down the [Ctrl] key and operating the [F] key.

mmummmrarmammTTn'nmnn'n 't



The Fount Palette

pages 10 to 13

Teach File -

Operating Manual

The Fount Paletteis displayed down the left hand side of the edit
screen and, as figure 2.1 shows, comprises a number of boxes,
inside each of which is displayed the capital letter ‘A’ or, in the
case of a logo fount, a small icon.

Green Background
indicates which
fount is selected.

Character shows style,
baseline & italic angles,
block, edge & shadow
attributes.

Display Fount
number.

Logo Icon

Figure 2.1. The Fount Palette

The number and type of Display Founts/logos ina Fount Palette
can vary from page to page. The maximum number of Display
Founts/logos that can be held in a Fount Palette is 4096. The
minimum is one.

Each capital ‘A’ shows you the style, whether or not an outline,
block and or drop shadow are present, the direction of italicsand
the angle of the baseline. In the case of alogo fount, the letter 'A’
is replaced by a small colour icon of the first logo in the Master
Logo Typeface.

[
)



Motif ESP Character Generator

Scrolling up and down Operating the Trackerball up and Fiown will allow you to scrol

through the Fount Palette. Notice, as you do so, the grees

the Fount Palette background. This shows you the ‘selected’ Display Fount. Alsc
take a look at the Text Status Row at the bottom of the screes
There you will be able to see the fount number and the height o
the ‘selected” display fount/logo.

. Toselecta Display Fount from Fount Palette, operate the Trackes-
Selecting a Fount from ball until the Display Fount you want is highlighted and ther
the Fount Palette operate either the [SELECT] key or the [ACCEPT] key. If vou
operate the [ACCEPT] key, the Fount Palette is automaticalls
removed from the Edit Display.

When you select a fount/logo from the Fount Palette, the char-
. acter (if any) your cursor is on is immediately changed or
processed to the new style or size.

If you choose to leave the Fount Palette on display (bv pressing
the [SELECT] key instead of the [ACCEPT] key), you can return
to the Fount Palette at any time with the Arrow Cursor.

Removing the Fount To remove the Fount Palette, without selecting a Display Fount

Palette position the arrow cursor over the Fount Palette and operate the
[QUIT] key.

Selecting founts by To select a Display Fount using the number method, press and

hold down the [FOUNT] key (top left hand corner of the kev-
board) and type in the fount number using either number keys
along the top of the QWERTY keyboard or the numeric kevpad.

number

Please note: When selecting founts by number it is not necessary tc
have the Fount Palette on display.

A final point worth remembering is that the selected Display

Fount may not contain a complete character set, in which case
Motif may have to process certain characters as you type.
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By looking at the Fount Palette and the Text Status Row (for the
character height) you can get a pretty good idea as to how each
Display Fount will look when displayed on the television screen.
However, for more detailed information about a particular
Display Fount you need to look at the Fount Setup Menu, as
shown on figure 2.2 below.

The quickest way to display the Fount Setup Menu is to use the
‘Hot Key’ method by operating the [Ctrl] key with the [F] kev
once if the Fount Palette is on display, or twice if it is not.

Fount Setup

Typeface: [ M| ROCKWELL

Height 20 Lines  Founts Available
Diagonal: Italic: Width: ¢ Other:
Quality: Superior

Standard Effects
Edge: Block: Shadow:*  Bold:

Special Effects

Emboss: Neon: Double Edge:
Character Process

Clear

Add Preview

Replace

Figure 2.2. The Fount Setup menu

Looking at the Fount Setup menu in figure 2.2 you will see the
name of the selected Display Fount, its display height in televi-
sion scan lines, and various attribute headings, each of which
has a sub-menu attached to it containing further information,
such as the angle of baseline, thickness of edge, etc.

2.5
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Adot, or 'bullet mark’, is displayed beside attributes which have
beenset. Forexample, anitalic display fount with an outlineand
adrop shadow will show ablack dot alongside its ‘Italic’, ‘Edge’
and ‘Shadow” attributes. If you select these attributes the exact
angle of the italics, the thickness of the outline, as well as the
depth, direction and softness of the drop shadow are shown.

An attribute sub-menu is displayed by either highlighting the
appropriate attribute with the Trackerball or cursor keys and
operating the [SELECT] key, or by ‘hot-keying’ the [Ctrl] key
with the letter which is coloured in the attribute heading. For
example, when selecting either ‘Italic’, ‘Edge’ or ‘shadow’, you
would operate the [Ctrl] key with either the [I], [G] or [S] key,
respectively.

'After you have finished viewing or modifying a fount attribute

menu, operate the [QUIT] or [ACCEPT] key.

A plain Display Fount (upright, horizontal baseline, no edge or
shadow) contains only one attribute, its size, so we'll deal with
size first.

Although there are three ways to change the size or height of a
Display Fount, in this section we will show you how to change
the size using the Fount Setup menu.

Changing the size of a Display Fount using the ‘Point and Select’
method, as well as Area Sizing', whilst editing text are dealt with later.

A Display Fount can be any size from 6 TV lines to full screen
(576 TV lines/625 or 486 TV lines/525) and the size, or height, of
the selected Display Fount is shown in the Text Status Row just
below the Safe Title Area.

To change the size of a Display Fount within the Fount Setup
menuy, first highlight the word "Height” and enter the new size
using the numeric keys along the top of the QWERTY keyboard.

I R il
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the Fount Palette

The 'Quit' function

Block and drop shadows

Character outline

Diagonal text
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If you make an error, use the back-space key (top right hand
corner of the QWERTY keyboard) until the error is cleared and
retype the desired size.

Having entered a new character height you now have a choice.
You can select “Add’, in which case you'll create a new Display
Fount which is added to the Fount Palette or you can select
‘Replace’. Selecting ‘Replace’ changes the height of the currentlv
selected Display Fount, as well as all existing text using the same
fountnumber in the current page you are working on. However,
characters in other pages using the same fount number are not
affected.

To select‘Add’ or ‘Replace’, highlight ‘Add’ or ‘Replace’ at the
bottom of the Fount Setup menu and operate the [SELECT] key.
Alternatively, ‘Hot Key” with the [Ctrl] key and the [A] or [R]
key.

If you decide not to proceed with the changes made to the Fount
Setup menu then operate the [QUIT] key.

Other attributes, such as Diagonal, Italic, Edge, Shadow etc., can
be altered by first highlighting the appropriate attribute, oper-
ating the [SELECT] key and then making changes as follows
using the number keys in the QWERTY keyboard.

When selecting a block or drop shadow, use the diagram in
figure 2.3 on page 2.8 to determine the correct angle to enter.
The amount of offset is entered as a percentage of the character
height.

The thickness of the outline is entered as a percentage of the
character height.

When selecting a diagonal baseline, again use the diagram in
figure 2.3 to determine the correct angle of baseline to enter. If,
for example, you select a 180° baseline you will end up with
upside down text.
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talic characters

“haracter width

slobal Width Offset

Leading Offset
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270°
Figure 2.3. Increments of 15° around a circle

When selecting italics use the diagram in figure 2.4 to determine
the angle to enter. The maximum italic angle that can be entered
is45°(-45°) but for best results resist going above 15°(-15°). You'll
find that 13°(-13°) is the average angle of most italicised type-
faces.

Figure 2.4. Angle of italic characters

Width allows you to stretch or contract a typeface horizontally. It
does not affect character thickness. 200% will double the width
of a typeface, whilst 50% will halve it.

The inter-character spacing and the space between each word
can be increased or decreased in 1/16 pixel steps using the
Global Width Offset function. Placing a minus sign (-) in front of
a number will decrease the space in which each character
resides.

The distance between rows of text can be increased or decreased
in one line steps using the Leading Offset function. Placing 2
minus sign (-) in front of a number will decrease the space
between rows.
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Normally, when a semi-transparent character is placed over
another character, a different colour is displayed at the points
where the two characters overlap. The placing of one colour
over another is known as ‘overprinting’. This problem can be
overcome by switching the 'Overprint’ function off.

Using the optional internal coder/keyer, you can fill semi-
transparant text without '‘Overprint’ with the input video.

Display Fount Inversion is available in the x or y axis or both. In
the x axis characters are displayed mirror fashion. In the y axis
they are displayed upside down. The Inversion function can
be found in the 'Other’' sub-menu. Operate the [SELECT ] kev
unti] the required XY inversion is displayed.

The edge of a Display Fount can be softened using the Softness
function. To change the softness level position highlight the
word ‘Softness’ in the ‘Other’ menu and operate the [SELECT]
key until the desired softness level is displayed. '
Note: Applying softness to a Display Fount increases the time taken
to process each character.

The thickness of a Display Fount can be increased (not de-
creased) by a percentage of the character height to achieve a
‘bold” effect. To increase the thickness select ‘Bold” from the
Standard Effects box.

Three special effects are provided. These are Emboss, Neon and
Double Edge. Only one Special Effect can be selected per
Display Fount. Before a Special Effect can be selected all ‘Stand-
ard Effects’ that have been set must be cleared first. This does
not apply to the ‘height’, “diagonal’, ‘width” and ‘other” at-
tributes. To assist you, the neon and emboss attribute menus
already contain a set of default settings which, of course, you can
change if you wish.

Selecting the ‘Clear’ function at the bottom of the Fount Setup
menu cancels, with the exception of size, all changes made to the
fount attributes.
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Selecting the ‘Preview’ function at the bottom of the Fount Setur
menu displays a character showing all the selected attributes
The maximum height of the ‘preview’ character is 43 TV lines

After you have entered all the changes you want to make to =
Attribute Setup menu, operate the [ACCEPT] key. This wi_
return you to the main Fount Setup menu (figure 2.2, page 2.3
which, from now on, will show a black dot against the atributes
you've just changed.

Note: Only after you've completed all the changes you want to make &
a Display Fount, do you need to select the ‘Add’ or ‘Replace’ funciaoms

See page 2.7,

A choice of three Fount Processing qualities is provided, name
'Superior’, 'Regular' and 'Basic’.  'Superior, with its unique
Guassian filtering, takes a little longer but guarantees tvpo-
graphic excellence. 'Regular’ and 'Basic’, on the other hand, are
faster but do not feature Guassian filtering and, as such, certain
characters may flicker slightly, (625/50 characters only).

To select the Quality of Fount processing, highlight the r
headed 'QUALITY' and operate the [SELECT] kev to select
‘Superior’, 'Regular’ or 'Basic’.

Finally, the 'Founts Available' function in the Fount Setup menu
gives you a listing of all the Display Founts that have been
processed from the Master Typeface. See page 2.12 for further
information.

Character Processor

You can instruct instruct the Fount Processor to create a Display
Fount before using it.  You can choose to process the enfire
typeface or any of the following:-

a)  Upper and lower case characters and numbers only - no
punctuation marks or accents.

b)  All those characters that can be selected by the key

For example, if a French keyboard layout is selected in the L
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Selecting the Full Fount
Processor
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Setup menu then the appropriate accents will be processed as
well. Thisisnot the case, of course, with an English keyboard.
c)  Those characters that can only be selected when pressing
the [ALT] key.

d)  Those characters that can only be selected when pressing
the [ALT GR] key.

e)  Any user selected characters.

Before using the full fount process, enter all the necessary
attributes in the Fount Setup menu.

Control of the full fount processor can be found within the
Character Process menu. This can be selected by operating the
[CTRL] key with the [F], [F] and [C] keys, or by selecting the
words 'Character Process' from within the Fount Setup menu.
The Character Process Menu is shown in figure 2.5 below.

Character Process

User Choice - (enter characters below) Execute
1234567890 ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijklmnopqrstuvxwyz

Keytops Alt Keys

Alt Gr Keys All Characters

FOUNT - QUIT aborts process

Processing all characters

Figure 2.5. The Character Process menu

To process all the characters in a typeface, including all special
characters, foreign language characters and accents, point and
select 'All Characters' from the Character Process menu, or
operate the [CTRL] key with the [C] key. The character shown
at the top of the Character Process Menu is the one being
processed at that time.
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Tostop the full fount process, operate the[FOUNT] key with the
[QUIT] key. To resume the full fount process point and selec:
‘All Characters' again.

It is not possible to quit the Character Process menu whilst the
full fount processor is active. You have to stop the Full Fount
Process first by operat ing the [FOUNT] key with the [QUIT] (or
wait for the Full Fount Process to finish) before operating the
[QUIT] key to return to the Character Process menu.

Most Postscript typefaces include a selection of special chara:-
ters which can only be accessed by operating the[ ALT] or [ALT
GR] key with the appropriate character key. The special charac-
ters that can be selected from your particular keyboard can be
determined at the back of the manual where the layouts of the
ALT and ALT GR keyboards can be found.

To start processing these special characters, point and select the
words'AltKeys' or'Alt GrKeys' or operate the [CONTROL] key
with the [A] or [L] keys.

To process those characters accessible from the standard lan-
guage layout of your keyboard, including all appropriate ac-
cents, point and select the word 'Keytops'.

Whenever the Character Process menu is selected a row of all
upper and lower case characters and numbers is shown in the
upper section- see figure 2.5. To process these, point and select
the word 'Execute’.

To process the numbers and upper case characters only, select
and highlight the row of characters and operate the [DELETE]
key until all the lower case characters have disappeared. Then
point and select the word "Execute’.

To process your own selection of characters, just enter the
characters of your choice. Having done that, point and select the
word 'Execute’.
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Selecting Master Typefaces

So far we’ve shown you how to change the attributes of a Display
Fount. Now we'll show you how to select a different typeface.

The name of the Master Typeface from which the ‘selected’
Display Fount was processed is displayed at the top of the Fount
Setup Menu - see figure 2.2.

Toselect a different typeface first highlight the word ‘Typeface:’
and operate the [SELECT] key. This will display the ‘Typeface
Listing’ menu as shown in figure 2.6 below.

When first selected, the Typeface Listing menu will display two
green selection bars; one in the ‘Typeface String’ box, the other at
the top of the Typeface Directory.

Typeface Listing

[M] courier Bold oblique
[m] Ellington Extra Bold Italic
[14] Ford Logo - September Launch

(4] Futura Bold
Source (M| DR Luglish
Symbol | [M] _Qui” Script
[4] Bodini Bold - h
Suing Bold elect Bar

[M] Times Bold

Founts Available

Figure 2.6. The Typeface Listing menu
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The ‘Typeface String’ box allows you to search for a particular
typeface or a family of typefaces. The Asterisk represents a ‘wild
card’. If nothing is entered except the asterisk, all available
typefaces will be listed, as is the case when you first select the
Typeface Listing menu. If the name of a particular typeface is
entered without an asterisk, for example “Times Roman Con-
densed”, then only that typeface will be searched for and dis-
played if available. If, on the other hand, “Times*” is entered
then all available typefaces of the ‘Times’ family will be listed.

Available typefaces (and Logo Masters) are displayed in alpha-
betical order and can be scrolled up and down the Typeface
Directory with the Trackerball or Cursor up and down keys.
Those typefaces along side the ‘M’ and '4' Source Symbols are
displayed in their own style.

Operating the cursor left and right keys toggles the green selec-

tion bar between the 'Typeface String’ box and the ‘Founts Avail-

able’ box.
The meaning of the Source Symbols are as follows:-

ymbols

M | = Motif Typeface Master (Postscript Type 1 Data).

LM | = Motif Logo Master (GBRK Data).

4 = Aston 4/Caption Master Typeface (Run Length Data).

L4 | = Aston 4/Caption Logo Master ( Run Length Data).

14 Chapter 2

To select a typeface from the Typeface Listing menu, operate the
Trackerball up or down until the chosen typeface is highlighted
then operate the [ACCEPT] key. After selecting a typeface the
Fount Setup menu reappears showing the name of the newly
selected typeface.
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Display Founts and Typefaces - The details

So far we’ve shown you how to display a list of your Master
Typefaces and how to make Display Founts. Now we’ll show
you how the Motif can give you more detailed information about
each typeface, as well as provide you with lists of the Display
Founts you've processed so far.

Detailed information about a Master Typeface or Logo file can be
obtained whilst editing text. Simply select a character or logo
and operate the [FOUNT] key with the [HELP] key. This will
display detailed information (original name, origin, creation
date, etc.), about the Master Typeface or Master Logo file from
which the selected character or logo was processed. The format
and layout of the typeface/logo information window depends
upon the type of character or logo you've selected. For example,
the Master Logo information window shows you how many
logos there are in the Master Logo file, whereas the Postscript
and Aston 4 Master Typeface information windows do not.

The ‘Fount Help’ function will be found particularly useful
when trying to select a logo from a logo fount which contains
several logos and you’re not quite sure which alpha-numeric key
topress. A quick look at “Fount Help’ will show how many logos
are available, a brief description of each logo and under which
keys they are located.

The Display Fount Information facility provides you with all the
details you will ever need about the Display Founts that are
currently available.

For example, it will let you see which founts are available
together with their attributes (size, italics, shadows, etc.); search
for founts of a particular typeface; copy founts with page files
and typefaces from one Motif to another using floppy disks; see
how many characters are in a particular Display Fount; delete
founts and determine how much memory each fount is occupy-

Ing
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The Display Fount information can be accessed whilst editing
text, such as listing all available founts that are similar to the
Display Fount you are working with or seeing which characters
and logos are available within the selected display fount.

There are two ways to list available display founts; from the
Directory or whilst editing text. We shall deal with the Directory
method of selection first.

Select Directory from the Utils menu, position the cursor on the
row headed Type: and operate the [SELECT] key until the
words ‘Typefaces’ appear.

Select 'Execute’ to list all available Master Typefaces.

Move the cursor bar down the screen and position it over the
name of the typeface whose Display Founts you want to have a
look at.

Select 'Look'. This will display the Typeface Information menu
which will tell you all need to know about the selected typeface,
see figure 2.7, opposite.

To list all the Display Founts that have been made from the
selected typeface, select FOUNTS AVAILABLE from the bot-
tom of the Typeface Information menu. This will display the
Display Founts Listing menu as shown in figure 2.8.

The Display Founts Listing menu lists the founts in size order,
followed by the founts that are used for displaying the letter A
icons in the Fount Palettes. Such founts are only listed by
request and are displayed along side the ‘<>’ sign.

Rather than listing all the founts associated with the typeface
shown at the top of the Display Founts list, you can view only
those founts that include particular attributes.

For example, you may want to list only edged and drop shad-
owed Display Founts of a particular height. Just below the
name of the typeface you will see an area in which all the fount
attributes are listed.

The first attribute is 'Height'. If you position the cursor bar over
the word height you can enter the size of Display Founts you
want to list.
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Information for typeface: 20th CENTURY SEMI BOLD
20th Century Semi Bold (001.002)

Created: 19 Feb 1993 10:28
by: STARTER
Source:  Postscript Type 1
Language: Roman/ Greek

Version: V1.1
Size: 63 kb
Kerned: Yes

JTINA AN ELITE View Print

Figure 2.7. Typeface Information menu

The other attributes can be selected with the Cursor Bar and
operating the [SELECT] key.  Selected attributes are shown
against a dot or minus sign. Operating the [SELECT] key once
displays a dot; operating the [SELECT] key twice displays a
minus sign; operating the [SELECT] key three times deselects
the attribute.

A dot instructs the Motif to list only those typefaces of the size
chosen with this attribute.

A minus sign means list everything of the size chosen that does
not have this attribute.

Onceall the attributes have been set, select the word 'Execute’. If
the display fount you are looking for doesn't exist a message ‘No
founts’ will be displayed.

The next or previous typeface in alphabetical order can be
selected by highlighting and selecting either 'Next Typeface' or
"Last Typeface'.

2.17
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FOUNTS FROM (M| CANTORIA SEMI BOLD

Height 0 (0 = any height) Quality: All
Diagonal Italic  Width Invert  Soft

Edge Block Shadow Bold Line Standard 625
Emboss Neon Double Edge <Palette Character

Execute Next typeface Last typeface

Height Italic Invert Edge -Block- --Shadow-- Bold Speca
Angle Width Soft Size Dir Size Dir Soft

1 . . 70.0 . .

24 . .o e . 4.0 45

36 3 .70 .. . . . 3.0

36 . 12 . e 18.0 48 .

43 . 15 . e . . 20

55 . . . X . 50

<

Look Delete Copy Compress Print Size

Figure 2.8. The Founts Listing menu

) ; You can get detailed information about alisted Display Fountby
Getting more detailed positioning the Cursor Bar over it and selecting LOOK. This will
information display the menu shown in figure 2.9 which displays all the
attributes of the Display Fount, the creation date, the Lser
Account that was selected at the time it was created and the
characters that have been processed since. It willalso tell vou if
compression is required: yes or no. If 'yes' is displayed then
operate the [QUIT] key once and select COMPRESS from the
row headed ‘Selected’. Compressionis only likely tobe required
when dealing with logos, especially after a logo has been modi-
fied.

: A Display Fount can be deleted from the Fount Listing menu by
Jeleting founts highlighting it with the Cursor Bar, selecting DELETE, entering
the password (if asked), and operating the [ACCEPT] key.

Care is required when deleting Display Founts because, al-
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FOUNT FROM EZOTH CENTURY SEMI BOLD

Height 40 lines

Block 20.0% Edge 8.0% Direction 315°
Creation date: 31 Mar1993 16:02 Version: V1.2
User: STARTER Line Standard: 625
Size: 37kb Quality: Superior

Compression required: No

Characters processed:
BCDEJKST Vacdehiklmnorstwy

Print

Copying founts

Tagging

Copying founts and
typefaces with Page
Files

Figure 2.9. Detailed Fount menu

though you yourself may be finished with a fount, somebody
else in another User Account may still need it.

Display Founts can be copied from one user account to another
or to a removable Syquest Disk or 3.5 inch floppy, or to another
Motif over the optional Network facility.

Tagging is available so that more than one display fount can be
copied or deleted at a time. To tag a Display Fount, highlight it
with the Cursor Bar and operate the [SELECT] key. A small
letter 't' is displayed next to each Display Fount that has been
tagged. Repeat to untag a Display Fount. To tag or untag all
Display Founts, operate the [SELECT] key with the [SHIFT]
key.

You might want to copy your Page File on to a 3.5 inch floppy
disk for playback purposes on another Motif. If so, then it makes
sense to copy the founts and the typefaces used in the Page File
at the same time. This can be done via the Copy routine in the
main Directory menu. Simply select the option ‘Founts with
typefaces and page file’ when prompted to do so before copying
the page file.

2.19
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Viewing the Founts List whilst Editing Text

It is also possible to list available founts whilst editing text.
The first method is to operate the [FOUNT] key with the [HELP]
key. This will take you directly to the Typeface Information
menu from which you can gainaccess to the Available Fountslist
by selecting 'FOUNTS AVAILABLE'. Operating the [QUIT]
key will return you to the Text Editing mode.

The second method is to display the Fount Setup menu, as
shown in figure 2.2 on page 2.5, and to select * FOUNTS
AVAILABLE’. This will take you directly to the ‘Available
Founts List’, so bypassing the Directory and Fount Information
‘menu. The Display Founts listed will be those related to the
Typeface shown at the top of the Fount Setup menu.

You can select a Display Fount straight from the ‘Available
Founts List’ and add it to the Fount Palette via the Fount Setup
menu. Simply highlight the Display Fount from the ‘Available
Founts List’ and operate the [ACCEPT] key, followed by [Ctrl]
+ [A]

Operating the [QUIT] key also returns you back to the Fount
Setup menu but without selecting a Display Fount from the
’Available Founts List'.

Attribute Copy

The attributes of a character, such as its style, size, angle, colour
etc., can be stored in special memory for later recall. You will
find this facility particularly useful when you want to quickly
copy the attributes of a particular character from one page to
another or select a particular set of character attributes by name.
For example, if you were working for a programme called ‘News
at Six’, Attribute Copy will allow you to go the Character
Attributes menu and select the correct display fount by name,
e.g. 'News at Six - lower 3rd’.
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There are two ways to copy and recall the attributes of an
existing character. The first is as follows:-

a)  Point and select the character whose attributes you want
to copy.

b)  Pressthe [LETTER] key with the [SELECT] key. This will
display the ‘Assign Attribute Key’ menu as shown in figure
2.10.

c)  Enter anumber from 0 to 9 and press the [ACCEPT] kev.
After a couple of seconds a message will appear telling you that
the attribute has been saved.

d) Toselect a set of character attributes stored in this way,
simply press the [LETTER] key with the appropriate number
key along the top of the keyboard

Assign Attribute Key

C - Please Enter Number Key: 0

Figure 2.10. The Assign Attribute Key menu

The second way to copy and select a character attribute is as
follows:-

a)  Point and select the character whose attributes you want
to copy.

b)  Display the File Menu and select ‘Character Attributes’.
This will display the Character Attributes menu as shown in
figure 2.12. Select ‘Save”, enter the name you wish to use for
recalling the set of character attributes and operate the [AC-
CEPT] key. The name you entered will now appear in the list of
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File

(‘ Character Attributes
Page Files

User Accounts
Setup Palettes

Cursor Position
Ascii Text File
Log Off

Figure 2.11. The File/Character Attributes command

attributes, indicating that the attributes have been stored suc-
cessfully.

¢)  Torecall a set of character attributes from the Character
Attributes menu, display the File Menu and select ‘Character
Attributes’. Highlight the appropriate attribute name, select the
word ‘Recall’ and operate the [ACCEPT] key twice. You may
now continue typing using the selected set of character at-
tributes.

Character Attributes

News at 6 - lower 3rd
Lunch time News
Headlines

Play School 1

Play School 2

Save Recall Delete Preview

Figure 2.12 The Character Attributes menu
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To delete a set of character atiributes from the Character At-
tributes menu, highlight its name then select ‘Delete’.

To preview a set of attributes, highlight its name then select
‘Preview’. This will assign all the attributes toa capital ‘A’ which
will be displayed over the Character Attributes menu in a
maximum size of 30 TV lines.

Please note: It is not possible to delete or preview a set of character
attributes that was saved using the keyboard method (the first method).
However, such a set of attributes can be overwritten at anytime by
selecting a character with a different set of attributes and saving them
with the same number.
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CHAPTER 3
Editing Text

In Chapter Three you’ll learn how to enter and edit text , select
Display Founts and text colours, as well as enter TABs, add
underlines and place text in coloured boxes. This chapter also
covers dynamic presentations such as roll, crawl, reveal, zip
and Vector special effects.

o TYTooe]
| letter | JDelere

Introduction

Figure 3.1. The editing keys

. . To completely clear the Edit Display operate the [PAGE] key
Starting with a clean with the [CLEAR] key. You'll find the [PAGE] key in the bottom
page left hand corner of the left hand block of keys and the [CLEAR]
key just left of the Trackerball.
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Whenever you clear a page, Colour 1 and Fount 1 are automati-
cally selected and the Chequered Cursor is displayed in the top
left hand corner of the Safe Title Area.

The Chequered Cursor tells you that the cursor is ‘floating’. In
other words, it isn’t sitting on an existing row of text. If it were,
it would either be a Solid Cursor or an Outline Cursor, see page
1.12 for further details.

To enter a row of text in the middle of the screen operate the
Cursor Down key (number 2 in the numeric keypad) until the
Chequered Cursor is halfway down the screen and start typing.
Alternatively, use the Trackerball to position the Arrow Cursor
and operate either the [ACCEPT] key or the [SELECT] key.

When you reach the end of the row operate the [RETURN] key
and type in another row of text. If you continue to type off the
right hand side of the screen, operate the Cursor Left key until the
cursor reappears and operate the [RETURN] key with one of the
[SHIFT] keys. This will move all of the text to the right of the
cursor to the next row down.

Inorder tocarry out the editing instructions that follow youneed
to enter at least three rows of text.

Almost all of the editing functions require you to position the
cursor either on a row or over a character or logo first. So when
we say ‘point and select’ we mean locate the Arrow cursor over
a row or word and operate the [SELECT] key. Once a row or
character has been selected, you can use the cursor shift keys to
move the Outline cursor around the block of text you are editing.

‘Point and select’ the row first, then press and hold the [ROW]
key and operate any of the cursor keys, with the exception of the
Cursor Home key [5]. Notice how the row swaps position with
the other rows as it passes over them.
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Note: Incremental Row Shift only affects text from the cursor position
to the end of the row.

‘Point and select’ a character, then press and hold down the
[ROW] and [Inc SHIFT] keys and operate the cursor keys
(again with the exception of number 5 key) to move the text to the
required position on the screen. If you wish tomovea whole row
in small increments, make sure the cursor is positioned on the
first character of the row.

Notice how the text stops moving when the keys are released
regardless of whether the texthas moved as often as the number
of times the cursor key was depressed. However, if you wish the
text to move say 7 increments and you press the direction keys
very quickly, the text will continue to move the required number
ofincrements, but only as long as you keep the [ROW] and [Inc
SHIFT] keys depressed.

To centre a row of text, ‘Point and select’ the row reqmred and
depress the [ROW] and [CENTRE] keys.

To centre a whole page or large section of text horizontally,
select the top most row of the section of text you wish to centre
and press the [PAGE] and [CENTRE] keys.

Note: Only text on and below the cursor will centre; text above the
cursor position will remain unchanged.

Operating the [AREA] key with the [CENTRE] key will centre
all the text within the selected display plane vertically.

Normally when you centre a row or page, the text is aligned
down the centre of the screen. The Floating Centre facility
allows you to set up a centre point whichis not aligned down the
centre of the screen.

Therearetwoways toselect your Floating Centre Point. Youcan
either use the vertical location of the cursor or you can enter a
number based upon the number of pixels in from the left hand
side of the screen. The centre point of the screen is 359 pixels in
from the left.
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The Floating Centre Point is selected via the Page/Row Centre
setup menu which is displayed by selecting ‘Centre:Page’ from
the Edit menu. See figure 3.2.

Note: If Floating Centre Point is already selected then you will see
‘Centre:Floating’ in the Edit menu instead of ‘Centre:Page’. Also, if
you are going to use the cursor to determine the location of your
Floating Centre Point then position it using either the Trackerball or

the cursor left and right keys before selecting the Page/Row Centre
setup menu.

Page/Row Centre

Centre Type : Page

Floating Centre Setup
Centre To Cursor
Page Centre

Floating Centre

Figure 3.2. The Floating Centre Setup menu

When you first select the Page/Row Centre setup menu, the row
headed ‘Centre Type’ will display the word ‘Page’, indicating
that the normal page centre facility is selected. Highlighting this
row and operating the [SELECT] key will change the word
"Page’ to ‘Floating’. You can now point and select either ‘Centre
ToCursor’ inwhich case the Floating Centre Point will be locatec
in line with the cursor (the pixel location of the cursor will be
displayed if you operate the [SELECT] key), 'Page Centre’ to
align it down the centre of the screen or ‘Floating Centre’.
Selecting ‘Floating Centre’ allows you to enter a number repre-
senting the number of pixels between the left hand side and the
Floating Centre Point.

TRl J Al A Al A e ] e et o e ) O el SO A

[N



Left and Right Justify

Row Insert

Row Delete

Operating Manual

Having made your selection operate the [ACCEPT] key. The
Floating Centre Point will remain selected within the current
page until the type of centre is changed back to ‘Page’. The
position of Floating Centre Point can be stored with each page
and therefore can be altered on a page by page basis.

Justification works from the cursor downwards. Tojustify aline
or a whole section of text, first ‘point and select’ on or above the
first row. Next, press down the [SHIFT] key and operate either
theright orleft cursor keys. The text will be justified as required.
Part of the text may disappear off the side of the screen, due to
the position of the cursor beforejustification. The text is notlost,
however, and will reappear if the cursor is repositioned and
justification is repeated.

This function allows you to insert additional rows of text be-
tween existing rows. First, select the row which you want to be
below the new row and press the [ROW] and [INSERT] keys.
The row you selected moves down and an empty row appears
above. The Row Insert function can be used to move a whole
block of text down the screen, simply by holding the keys down
until you have the required number of blank rows.

Row Delete works in two ways. You can either delete just the
text to the right of the cursor or the whole row. Ineither case, the
two keys to operate are [ROW] and [DELETE]. To delete the
whole row make sure the cursor is located on the first character
of the row, because the function only works from the cursor
position to the end of the row.

If you operate the [ROW] and [DELETE] keys twice, the whole
row is deleted, regardless of the position of the cursor, and all the
rows below move up by one row to fill the space.
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There are two ways to compress or expand a row of &=xt esther

by decreasing or increasing the spaces between each word or the
space occupied by each character.

Position the cursor on the row of text, press and hold down the
[ROW] key and operate the plus key to increase the interword
spaces or the minus key to decrease the interword spaces.

If you press and hold down the [ROW] key with the [INC
SHIFT] key whilst operating the plus and minus keys, vou
increase and decrease the character spaces as well as the interword
spaces.

The plus and minus keys can be found within the numerical
keypad.

The space between all rows of text below the cursor row can be
increased or decreased by operating the [AREA] key with the
plus and minus keys.

To move an individual character, select it and then press and
hold down the [LETTER] key and operate the cursor shift kevs.
The character will move according to how often you press the
cursor keys. If yourelease the[LETTER]key before the character
has moved the number of times pressed, the character will stop
moving.

To position the character more precisely, depress the [LETTER
key with the [INC SHIFT], together with the appropriate Cursor
shift key.

Note: Characters and rows can also be moved around the screern in
small increments by using the Trackerball instead of the Cursor shift

keys.
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Toinserta space in a row of text, ‘pomnt and select’ the character
to the right of where vou wish to add the space and press the
[LETTER] and [INSERT] kevs. You can now typeinaletterir
the space you have created. If you hold the [LETTER] and
[INSERT] keys down for more than half a second, the function
will repeat until you release the keys.

Another way toadd characters or words in amongst existing text
is to select the ‘Insert’ Mode. When in the ‘Insert’ mode, text to
the right of the cursor is moved one place to the right each time
a new character is entered.

To select the ‘Insert’ mode, operate the [LETTER] key with the
'I’key in the QWERTY keyboard. The word INSERT" at the left
hand end of the Text Status row will tell you when the ‘Insert’

mode is selected.

When the ‘Overtype’ mode is selected, as opposed to the ‘Insert’
mode, any existing character can be changed for another by
positioning the cursor over it and typing in a new one. .
To select the ‘Overtype’ mode, operate the [LETTER] key with
the ‘O’ key in the QWERTY keyboard. The word ‘OVERTYPE'
at the left hand end of the Text Status row will tell you when the
‘Overtype’ mode is selected.

Note: The 'Insert’ and *Overtype’ modes can also be selected using
‘point and select’. Simply ‘point and select’ the word OVERTYPE or
INSERT in the Text Status row and the two functions will toggle.

To delete a character, ‘point and select’ the character you no
longer require and depress the [LETTER] and [DELETE] keys.
If you keep the keys depressed the machine will continue to
delete characters until the keys are released.
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The [BACKSPACE] key, which is located in the top right hand
corner of the QWERTY keyboard, works in much the same way
as ‘Letter Delete’. The only difference being the cursor must be
located on the character to the right of the one you wish to delete,
rather than on it. Motif will continue to delete characters and
spaces until the key is released.

The Case Change function allows you to change existing text,
without retyping, from lower case to upper case, and vice versa,
on a character, row or page basis.

Tochange the case of asingle character, first‘pointand select’ the
character and then operate the [LETTER] key with one of the
[SHIFT] keys.

To change the case of a row of text operate the [ROW] key with
the [SHIFT] key. The function works from the cursor position
to the end of the row, so if you want to change the case of the
whole row, locate the cursor on or before the first character.

Tochange the case of a page of text operate the [PAGE] key with
the [SHIFT] key. Again, the function works downwards from
the row and character cursor position, so if you want to change
the case of the whole page position the cursor on or before the
first character of the top row of text.

'Point and select' the character, display the Fount Palette, oper-
ate the Trackerball or cursor up and down keys until the required
fount in the Fount Palette is highlighted and then operate the
[SELECT] key, (the Fount Palette is displayed by operating the
[Ctrl] key with the [F] key). For further information about the
Fount Palette please refer to pages 2.3 and 2.4.

After the [SELECT] key is operated the character your Cursor is

onwill change to the selected fount and the Text Status Row will
display the number of the newly selected fount.

Alternatively, operate the [ACCEPT] key. This has the same

0 O
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effect as operating the [SELECT] key except that the Fount
Palette disappears from view.

Repeat the above instructionand then operate the[FOUNT] key.
This will change the fount of all the characters to the right of the
cursor up to the next character space.

Repeat the above instruction for changing the fount of a single
character and then operate the [FOUNT] key twice. This will
change the fount of all the characters to the right of the cursor up
to the end of the row.

Note: When pressing the “Fount” key to change the fount of a word
or row, only the line of text selected will change. You must move the
cursor to the next row of text and repeat the operation to change the
fount on that row.

If you are familiar with the numbers of the founts in the Fount
Palette, you can bypass the Fount Palette altogether by holding
down the [FOUNT] key and entering a fount number using the
number keys in the QWERTY keyboard or the numeric keypad.
The rest of the word or row can then be changed as described
above.

To remove the Fount Palette whilst editing text, use the
Trackerball and position the cursor over one of the fount cells
and operate the [QUIT] key.

On page 2.6 we told you how to select a fount height from within
the Fount Attributes menu. Now we’ll show you how you can
change the height of a Display Fount whilst editing text.

First ‘Point and Select’ the character whose height you want to
change, then ‘Point and Select’ the number to the left of the
'Lines’ in the Text Status Row, (the number will be highlighted
by a green background). Operate the [SELECT] key, enter the
required height using the number keys along the top of the
QWERTY keyboard and finally operate the [ACCEPT] key.
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The selected character will change to the new height and the new
Display Fount will be added to the Fount Palette.

The height of the rest of the word or row can be changed to the
new Display Fount by immediately operating the [FOUNT] key
once for the rest of the word or twice for the rest of the row.

Note: Changing the size of a character in the above described manner
only affects the height. All other attributes such as italics, shadows,
etc., are not affected.

Area Editing

Area editing allows certain editing functions to be applied to a
group of text as defined by an outline cursor.

The editing functions that can be applied with Area Editing are
Fount Change, Colour Change, Case Change and Area Centre.

Area Editing only works with existing text. Avoid including

logos within the selected area, especially if the intention is to
fount or case change.

There are basically two ways to set the size and shape of the area
in which Area Editing will take place. You can use either the
Cursor left, right, up or down keys or the Trackerball. Which-
ever method you use, the first thing you must do is select your
start character from which the editing area can be defined. This
is done in the normal way by pointing and selecting and
encasing the selected character within an Outline Cursor.

To draw the editing area out from the selected character, press
and hold down the [AREA] key and operate the Trackerball or
the Cursor left, right, up or down keys until the desired area of
text is defined by the outline cursor. As you are doing so, a quick
look at the Lower System Status row will confirm that you are in
the Area Editing mode and not the Area Sizing. If the word
‘Sizing’ is displayed then you will have to operate the [QUIT]key
and access the main Edit Menu, from which you will be able to
select the correct function. This can be done quickly by operat-
ing the following in sequence:- [Ctrl] [E], [A], [SELECT],
[ACCEPT].
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Within the editing area now displayed you can change the
display fount and colour, as well as changing the text from
upper to lower case characters, and vice versa, using the Case
Change function. Area Centreisalsoavailable, butonly ona full
row basis. No other editing functions are available when Area
Editing is selected.

Operate the [QUIT] key to return to the normal editing mode.

Area Sizing

Area Sizing allows part or all the textin a single row to be resized
to any aspect ratio and angle. It also offers a very quick way of
moving part or all the text in a single row from one part of the
screen to another. It is not possible to use the Area Sizing
function on more than one row of text at a time.

Before using the Row Sizing function make sure that the main
Edit menu is displaying the words ‘Area Sizing’ and not ‘Area
Editing’. If necessary, point and select 'Area Editing’ to change
to ‘Area Sizing'.

The first step toward using the Area Sizing function is to select
the first or last character of the text you want to resize, then press
and hold down the [AREA] key and operate either the Tracker-
ball or the Cursor left and right keys to encompass the text with
the Area Outline Cursor.

Next, operate the [SELECT] key and adjust the shape of the Area
Outline Cursor to match the size and aspect ratio of the area in
which you want the encompassed text toreappear after process-
ing. Do this by holding down the [AREA] key and operate the
Trackerball or Cursor right and left keys.

To move the Area Outline Cursor from one part of the screen to
another, press and hold down the [SHIFT] key and operate the
Trackerball. Alternatively, just use the Trackerball to position
the arrow cursor and then operate the [SELECT] key. The
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Outline Cursor will reappear with its bottom left hand corner at
the point of the arrow cursor.

To change the angle of the Area Outline Cursor, press and hold
down the [AREA] key and operate either the plus key or minus
key located within the numeric keypad. For each key push the
angle of the box will change by 10 degrees. If you hold the
[AREA] key down with the [INC SHIFT] key, the angle will
change in one degree steps.

Having set the position, size, shapeand angle of the Area Outline
Cursor, operate the [ACCEPT] key. After a few seconds the
selected text (above the base line) will appear as a tight fit within
the AreaOutline Cursor. Alldescenderswillappearoutside and
below the Area Outline Cursor.

To move a block of text quickly from one part of the screen to
another, simply encompass the text with the Area Outline Cur-
sor, operate the [SELECT] key, press and hold down the shift
key, use the Trackerball to position the Area Outline Cursor and
finally operate the [ACCEPT] key. The text will then jump to the
new location as dictated by the position of the Area Outline
Cursor.

Prior to selecting a single character or logo for row sizing, you
have to point and select in the usual way but then hold downthe
[AREA] key and operate the Cursor left key followed by the
Cursor right key.

Row Priority lets you select a row of text and then display it in
front of, or behind, other rows of text.

If you’ve been following the instructions in the Teach File you
will know that it is possible to type as many rows of text as you
like, one upon the other. To move a row forwards or backwards
you need to:-

a) ‘Point and Select’ the row.
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b)  Select Row Priority from the Edit menu. This will display
the Row Priority menu showninfigure 3.3. The priority number
of the selected row is shown at the bottom of this menu. You can
move a row of text right to the back or to the front, or backwards
and forwards, one row at a time.

c)  Highlight the appropriate function and operate the
[SELECT] key.

Note as you do so how the Current Row Priority number
changes at the bottom of the menu. If you are moving a row of
text backwards or forwards one row at a time then operate the
[SELECT] key until the required priority number is displayed.

d)  Operate the [ACCEPT] key to return to the normal edit
mode.

A final word about row priority. When starting with a clear
page, the first row you type will be ‘priority 1, the second will
be ‘priority 2’, the third will be ‘priority 3’, etc. This applieseven
if the rows are typed one upon the other. This fact is worth
remembering, especially when you want to change the order in
which textis displayed when using the dynamic functions such
as 'Zip’ and ‘Reveal’, both of which are described in the chapter
dealing with Dynamic Presentations.

Row Priority

Push Row To Back
Push Row Back
Bring Row Forward
Bring Row To Front

Current Row Priority 12

Figure 3.3. The Row Priority menu
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1 The Text Status row at the bottom of the screen shows you the
page

number of the currently selected colour (the active colour). Just
to the right of the Text Status Row is the active colour box.
The active colour box comprises four colours. The large colour
square is the colour of the face of the character. The three smaller
squares, from top to bottom are the colours of the character edge,
the block and the shadow.

Edit Fount Colour Dynamics Plane File Software Utils

Active
Colour Number

Edit: Dynamic Overtype Colour12 Fount 3 48 Lines Static i’
Current Page 23 Next Page 24  News Week

Figure 3.4. The active colour number and colour box

As you move the cursor over existing text, the active colour
number in the Text Status row will change according to the
colour of the character over which the cursor is positioned. This
is demonstrated in Teach File on page 44.

1.14 Chapter 3
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Shadow Colour

Figure 3.5. The colour attributes of a character

The available colours can be seen by displaying the COLOUR
PALETTE. To display the Colour Palette, select the word
‘Colour’ from the top of the screen either by using the Trackerball

or by pressing [Ctrl] [C].
After selecting the “Colour” menu,

the Colour Palette will

appear down theright hand side of the screen, asshown in figure

3.6.

Colour of
character face

'Dark green background
indicates selected colour

Colours of
Edge,

Block and
Shadow

Colour Number

Figure 3.6. The Colour Palette
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The Colour Palette comprises a number of colour cells, each of
which canbe highlighted and selected by scrolling up and down
the palette using the Trackerball or the Cursor up and down
keys. When you first display the Colour Palette, the currently
selected colour is highlighted.

Position the cursor over the character, display the Colour Palette,
operate the Trackerball or cursor up and down keys until the
required colour in the Colour Palette is highlighted and then
operate the [SELECT] key.

After the [SELECT] key is operated the selected character wili
change to the new colour and the number of the new colour wil.
appear in the Text Status Row.

Alternatively, operate the [ACCEPT] key. This has the same
effect as operating the [SELECT] key but also removes the
Colour Palette from the Edit Display.

Repeat the above instruction and then operate the [COLOUR]
key. This will change the colour of all the characters to the right

of the cursor up to the next character space.

Repeat the above instruction for changing the colour of a single
character and then operate the [COLOUR] key twice. This will
change the colour of all the characters to the right of the cursor
up to the end of the row.

Note: When pressing the “Colour” key to change the colour of a word
or row, only the line of text selected will change. You must move the
cursor on to the next row of text and repeat the operation to change the
colour on that row.
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If you arefamiliar with the numbers of the colours in the Colour
Palette, you can bypass the Colour Palette altogether by holding
down the [COLOUR] key and entering a colour number using
the number keys in the QWERTY keyboard or the numeric
keypad. The rest of the word and then row can be changed as
before by pressing the [COLOUR] key once for the rest of the
word, twice for the rest of the row.

To remove the Colour Palette whilst editing text, use the
Trackerball to position the cursor over one of the colour cells
and operate the [QUIT] key.

Selecting New Colours

Apart from showing you the colour attributes (face, edge, block
and shadow) of the selected colour, the Active Colour Box canbe
used to gain access to the Colour Setup menu which will allow
you to select new colours and levels of opacity with the
Trackerball.

Colour Setup
Pick
Flip
Swap
Colour Face

Type Unshaded

Edge Colour
Block Colour
Shadow Colour

Face Colour

Figure 3.7. The Colour Setup menu
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There are two ways to select and display the Colour Setup menz
as shown in figure 3.7.

First, using the Trackerball, move the arrow cursor to the Acove
Colour Box, position it over the appropriate colour attribute ce
(face, edge, block or shadow) and operate the [SELECT] kev

Alternatively, operate the [COLOUR] key with the [HELP] ke
The Colour Setup menu contains the ChromaBall and a number
of headings, each of which can be activated with either the
Trackerball or the cursor shift keys.

Colours are chosen using the Trackerball. Luminance an:
opacity levels canalsobe selected when the ChromaBall is acove

Pick
Pick is a function which allows you to select colours from tex:
and logos etc., which are displayed on your current page. It
provides an ideal way of exactly matching colours.

Hip
Flip allows you to move the Colour Setup menu from the bottom
right hand corner to the top left hand corner, and vice versa.

Swap
Swap can be used when selecting gradated colours (shading

Gradated colours are selected by choosing ‘start’ and ‘end
colours. SWAP allows you to swap the 'start’ colour with the
‘end’ colour.

Colour

When activated, COLOUR allows you to select Face, Edge, Block
(2D edge) or Shadow by operating the [SELECT] key.

Type
Type allows you to elect whether a colour attribute should be
shaded or unshaded.

ri
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Functions in the Colour Setup menu can be activated by operat-
ing the Trackerball or the cursor shift keys until the required
function is highlighted by a green background or, in the case of
the ChromaBall, with a green square outline.

Once activated, single function headings, such as Pick, Flip and
Swap can selected by operating the [SELECT] key. With multi-
function headings, such as Colour and Type, operate the
[SELECT] key until the desired function is shown.

First, make sure that the word “Unshaded” is displayed along
side the word “Type”. If it is not then activate “type” and
operate the [SELECT] key until it is.

Next, highlight the ChromaBall then operate the Trackerball to
move the arrow cursor around tne multi-coloured disk until the
desired colour is displayed in the Active Colour Box below.

To change the luminance level of the colour, press and hold
down the [COLOUR] key and operate the cursor up and down
keys. Cursor up to increase the luminance level and cursor
down to lower it.

Note: Luminance levels can only be changed when the ChromaBall is
activated.

To change the opacity (transparency) level of the colour, press
and hold down the [COLOUR] key and operate the cursor left
and right keys. Cursor right to increase the opacity level and
cursor left to lower it.

Note: Opacity levels can only be changed when the ChromaBall is
activated.

To apply the newly selected colour on a temporary basis to all
text assigned with the same colour number, operate the
[SELECT) key. Continue selecting colours and operating the
[SELECT] key until the desired colour has been found, then
operate the [ACCEPT] key. This will finally assign the newly
selected colour and remove the Colour Setup menu.
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Operating the [QUIT] key instead of the [ACCEPT] key, returns
you to the original colour without applying your changes.

Start Colour

End Colour —s -
Figure 3.8. The start and end colours of a shaded colour

Shaded colours, which can be applied to all four colour at-
tributes of a character, are created by selecting a “Start’ colour
and an’End’ colour. The ‘Start’ colour is the one at the top of the
selected colour cell in the Active Colour Box.

Before selecting a ‘Start’ or ‘End’ colour make sure that the worc
‘Start’ or ‘End’ is displayed along side the heading "Type'. If i:
is not then activate the word “Type” and operate the [SELECT_
key until ‘Start’ or 'End’ is displayed.

Having made sure that the word “Start’ or ‘End’ is displavec
along side the heading Type' select the colour, luminance anc
opacity in the way already described.

The ‘Start’ or ‘End’ colours can be swapped around by firs:
activating the heading “Swap” and operating the [SELECT] kev..

To pick up a colour from within a logo or colour image, display
the Colour Setup menu if you haven’t already done so, activate
the heading ‘Pick’ and then operate the [SELECT] key. This will
place the arrow head cursor back into the edit display. Use the
Trackerball or the cursor shift keys to position the cursor over the
desired colour. The actual colour at the tip of the arrow heac
cursor is shown in the Active Colour Box.

When you've found the colour you want, operate the [SELECT,
key to assign it to the selected text on a temporary basis or the
[ACCEPT] key to assign it permanently.

When in the ‘Pick’ mode, operate [Ctrl] [P] to recall the Colour
Setup menu.
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The Main Colour Setup Menu

So far we’ve shown you how to change the colour of the Actve
Colour Box using the Trackerball. Now we’ll show you how
change colour using colour reference numbers and slider con-
trols. For this we need to display the Main Colour Setup menu

shown below.
Main Colour Setup
Green 105 FEE
Blue PLYR . Col F
Red 19 B 1] T;p(;ulf]n:;zded
Intensity 198 S 1 © Swap Shade
ity 255 N ok
Opacity 255 Copy Colour

Figure 3.9. The Main Colour Setup menu

The Main Colour Setup menu can be displayed by holding down
one of the [Ctrl] keys whilst operating the [C] key twice. Alter-
natively, the Main Colour Setup menu can be displaved by
selecting ‘Colour’ from the Menu Selection Row at the top of the
screen and then operating one of the [Ctrl] keys with the [C] kev
once.

. Each of the 16.7 million colours available is made up of levels ot
Selecting colours by red, green and blue and this is graphically demonstrated by the
= number level indicators down the left hand side of the Main Colour
Setup menu.

To the left of each level indicator is a three digit number. These
show you the exact intensity of each of the colour components,
as well as luminance and opacity levels.
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To change a number, first select the number and the heading
(red, green, blue, etc.). This is done by operating the cursor kevs
until both are highlighted by a green background. Once acti-
vated, a number can be changed with the Trackerball or by firs:
operating the [BACKSPACE] key until the number has been
deleted and then entering a new number using the number keys
along the top of the QWERTY keyboard, (do not use the numer:-
cal keypad as this will activate one of the other headings).

The maximum number that can be entered is 255.

The ChromaBall, Pick and Swap functions all work in exactly the
same way as described on page 3.18.

The Copy Colour function lets you copy all four colour cells
The Copy Colour (face, ecFl)gye, block and shadow) t(zl the C(}))l}(l)ur Palette.
function

Proceed as follows: Firstactivate the heading ‘Copy Colour” anc
operate the [SELECT] key. This will display the Copy menu as
shown in figure 3.10 below.

Main Colour Setup

-Green 105 SRS 1
Colour Copy

Colour Face
Type Unshaded
Swap Shade

‘Copy To Existing Colour Entry

Copy To Next Available Entry: 17

Figure 3.10. The Copy Colour menu
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The Colour Copy menu provides two choices. You can either
copy to anexisting colour in the ColourPalette, in which case you
are prompted to enter the number of the colour you wish to
replace, or you can elect to have the colour added on to the end
of the Palette.

Replacing an existing
colour in the Colour

Palette

To replace an existing colour in the Colour Palette, select the
heading ‘Copy to Existing Colour Entry’. This will result in the
Colour Copy Entry menu being displayed, as shown in figure
3.11.

Enter the number of the cell where you want the colour toappear
in the Colour Palette using the number keys along the top of the
QWERTY keyboard. If you make a mistake, operate the[BACK-
SPACE] key. Operate the [ACCEPT] key to copy the colour to
the Colour Palette.

Adding a new colour to

To add the colour to the end of the Colour Palette, select the
heading ‘Copy to Next Available Entry’ from the Colour Copy

the Colour Palette menu and operate the [ACCEPT] key.

Main Colour Setup

Colour Copy

Colour Entry Copy Colour Face

Type Unshaded
Swap Shade

Please Enter Colour Number ;.
Please Accept

Figure 3.11. The Colour Entry Copy menu
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Installing Fount and Colour Palettes

Whenever youcreateanew User AccountFile, the Default Fount
and Colour Palettes incorporated within the Default Page File
are unlikely to be the founts and colours you would choose
yourself.

To create your own Fount Palette you need to do the following:-

1) Let’s say your Default Fount Palette contains 13 display founts
of which you only want to keep fount number five and add six
founts of your own choice.

The first thing you have to do is ‘replace” the first four displav
founts with founts of your own choice using the Fount Setup
menu. Here’s how.

Select Fount One(0), display the Fount Setup Menu, enter the
fount attributes for the new Display Fount and select ‘Replace’.
This will replace the original Display Fount with the new fount.
2) Repeat the above for the all other founts you want to replace.
In our example, this will be founts 2,3,4 and 6.

3) Select ‘Setup Palettes’ from the ‘FILE’ menu. This will display
the Palette Control menu as shown in figure 3.12.

4) Highlight and select the heading ‘Save Fount Palette’. This
will display the ‘Save Palette’ menu, as shown in figure 3.13.
Enter the number of entries you want to save (in our example this
will be ‘7’), and operate the [ACCEPT] key.

Palette Control

Save Fount Palette

Save Colour Palette
Recall Fount Palette
Recall Colour Palette

Figure 3.12. The Palette Control menu
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Save Palette

Current number of entries in palette 13

Enter number of palette entries to save 7

Figure 3.11. The Save Palette menu

Note: The number shown in the heading ‘Current number of entries
in palette’ refers to the number of entries in the current Fount Palette,
not the Default Fount Palette.

Alsonote: Ifyour Current Palette hasentries insay,0,1,2 3,4, 6,7 and
8butlocation 5isempty, the Save Default Palette routinewill only save
entries 1to4. In order to save the other entries a fount will have to be
added in location number 5. The easiest way to do this is to select
Display Fount number 4and select the’Add’ facility in the Fount Setup
menu. The ‘Add’ faaltty automatically adds the Display Fount to the
next vacant space in the current Palette.

5) From now on, as long as you don’t make any further changes
to the Fount Palette, the Default Palette you havejust created will
be stored with every page.

6) If you change the Fount Palette you can, if you wish, recall the
Default Fount Palette by repeating steps 3 to 4 but highlight and
select ‘Recall Fount Palette’ instead of ‘Save Fount Palette’.
Setting up a new Colour Palette is done in the same way, using
the same menus.

Finally, two points worth remembering are:

a) When you save the Fount or Colour Palette of the ‘Current’
page, it becomes the new Default Palette (make sure there are no
empty palette cells in between the first and last entries).

b) You can use the Setup Palette menus to transport palettes
from one page to another in the same file, or to a page in another
file in the same or different User Account File.
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Left hand margin Tab

Left hand Tab

Right hand Tab

Centre Tab

Teach File
pages 52 to 54
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Tabs

The following Tab types are provided:-

The position of this tab determines the left hand margin and is
usually positioned just inside the left hand side of the Safe Area.
Whenever the Line Feed Carriage Return key is operated the
Cursor will move left and down one row to the position of the
Left Hand Margin Tab.

Text entered from a Left Hand Tab position will be left justifiec.
The Cursor will move one character location to the right as eacr
new character is entered.

Text entered from a Right Hand Tab position will be right
justified. The Cursor remains in the Right Hand Tab position
and all existing text so tabbed will move one character to the left
as each new character is entered.

Text entered from a Centre Tab will be automatically centred to
the Centre Tab position.

Up to nine horizontal tabs can be set across a page. Each tab is
represented by a particular tab icon to indicate the tab type. The
tab icons are positioned just above the Safe Title Area. The left
hand margin is represented by a solid inverted triangle.The tab
iconsare shown in figure 3.14. Tab positions are stored with eac™
page. Clearing a page does not affect tab positions. The [TAB_
key is located above the Caps Lock key.

& ol
@)@? @b&‘? R V&&
& $ & &

Figure 3.14. The Tab Icons
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Inserting and deleting
Tabs

Tab Insert

Operating Manual

When the [TAB] key is operated the cursor will jump right to the
next tab location. When the [TAB] key is operated with the
[SHIFT] key the cursor will jump left to the next tab.

If no tabs are set, the tab key is inoperative.

If the cursor is located over a character, the character, as well as
all text toits right up to the next tabbed character, will jump to
the next tab position when the [TAB] key is operated

First, select TAB SETUP from the Edit menu. This will displayv
all existing tabs that are currently set, together with the Tab
Setup menu. If no tabs are set then only the left hand margin tab
will be shown by a solid inverted triangle, see figure 3.15.

»

}Idit Fount Colour Dynamics Plane File Software Utils

Tab Setup

TAB INSERT to insert new tab.
TAB DELETE to delete tab.
SELECT to move current tab.

ACCEPT to setup new tabs.
QUIT to restore old tabs

Figure 3.15. The Tab Setup menu

Toinsertatab, point with the Arrow Cursor where you want the
tab to be positioned and operate the [INSERT] key with the
[TAB]key. This will display the Setup Tab Type menu as shown
in figure 3.16. From the Setup Tab Type menu use the Tracker-
ball to highlight the required tab type and operate the [SELECT]
key. This will set the chosen tab typeand display theappropriate
tab icon.
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Tab Delete

Moving a Tab

Inserting and deleting
tabs whilst editing text

3.28 Chapter 3

Up to nine tabs canbe set. Awarning message will appear = vo
try to set more than nine tabs. You caninsert tabs to the le= o e
left hand margin tab if you wish.

Setup Tab Type

Please select required tab type:
Left hand tab

Right hand tab

Centre tab

Decimal tab

Figure 3.16. The Tab Setup menu

Todelete a tab, point at it with the Arrow Cursor and operas= &
[DELETE] key with the [TAB] key. The left hand marg= =
cannot be deleted.

Anexisting tab, including the lefthand margin tab, can be mowes
by first entering the Tab Setup menu then pointing at e
Arrow Cursor and operating the [SELECT] key and then poes-
ing at the new location and operating the [ACCEPT] kev

When all the tabs have been set operate the [ACCEPT] kev =
return to the normal editing mode. Any text associated with z
relocated tab will move to the new tab position when o=
[ACCEPT] key is operated.

Tabs can be also inserted and deleted whilst editing text.

To insert aTab whilst editing text, position the cursor first anc
then operate the [INSERT] key with the [TAB] key. This w
display the Setup Tab Type menu as shown in figure 3.16.
Highlight the required tab and operate the [SELECT] kev. This
will set the tab and return you straight back to the editing mode.
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Todeletea tab whilstediting text, operate the [TAB] key until the
cursor is positioned atthe tab point you want to delete, pressand
hold down the [DELETE] key and then operate the [TAB] key.

Note: When in the normal editing mode, the Tab Markers are not
displayed. Also, tabbed text cannot be moved left or right using Row
Left and Right Shift functions.

Boxed Text

Existing text can be ‘boxed’ using the Boxed Text facility. Text
can be boxed on a character, individual word, row word or full
row basis.

Text cannot be boxed as it is typed.

Single chﬂracter box
Ind1v1dual wordRXp

Full row box

The height of the box depends upon the characters being boxed
and whether or not ‘Height Lock’ has been selected. With
‘Height Lock’ unselected the height of the box is strictly control-
led by the character or characters being boxed. This is demon-
strated in figure 3.17. With ‘Height Lock' selected the height of
the box is based upon the number of pixels between the de-
scender line and the ascender line of the largest display fount
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Up to nine tabs can be set. A warning message will appear & you
try to set more than nine tabs. You caninsert tabs to the lefz of T
left hand margin tab if you wish.

Setup Tab Type

Please select required tab type:
Left hand tab

Right hand tab

Centre tab

Decimal tab

Figure 3.16. The Tab Setup menu

To delete a tab, point at it with the Arrow Cursor and operas= =
Tab Delete [DELETE] key with the [TAB] key. The left hand margs &=
cannot be deleted.

Anexisting tab, including the lefthand margin tab, can "vc move:
by first entering the Tab Setup menu then pointing at it with &
Arrow Cursor and operating the [SELECT] key and then poe=-
ing at the new location and operating the [ACCEPT] key

Moving a Tab

When all the tabs have been set operate the [ACCEPT' key
return to the normal editing mode. Any text associated w=th =
relocated tab will move to the new tab position when &
[ACCEPT] key is operated.

: ; Tabs can be also inserted and deleted whilst editing text.
Inserting and deleting

tabs whilst editing text ~ Toinsert aTab whilst editing text, position the cursor first and
then operate the [INSERT] key with the [TAB] kev. This wil
display the Setup Tab Type menu as shown in figure 3.1&
Highlight the required tab and operate the [SELECT ] key. This
will set the tab and return you straight back to the edmno mode
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The height of the box
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Todeleteatab whilstediting text, operate the [TAB] key until the
cursorispositioned at the tab point you want todelete, pressand
hold down the [DELETE] key and then operate the [TAB] key.

Note: When in the normal editing mode, the Tab Markers are not
displayed. Also, tabbed text cannot be moved left or right using Row
Left and Right Shift functions.

Boxed Text

Existing text can be ‘boxed” using the Boxed Text facility. Text
can be boxed on a character, individual word, row word or full
row basis.

Text cannot be boxed as it is typed.

Single chfJracter box
Individual box

Full row box

The height of the box depends upon the characters being boxed
and whether or not ‘Height Lock’ has been selected. With

- ‘Height Lock’ unselected the height of the box is strictly control-

led by the character or characters being boxed. This is demon-
strated in figure 3.17. With ‘Height Lock’ selected the height of
the box is based upon the number of pixels between the de-
scender line and the ascender line of the largest display fount
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within the row if row boxing is selected or within 2 wors =
‘word’ or '‘Row - broken’ is selected.

ma'

(Height Lock off)

Heightflockffon

(Height Lock on)

Figure 3.17. The effect of Height Lock

Standard box and Fast There are two types of box available - ‘standard box’ and ==
box’, the latter of which was developed for subtitling purposes

Box via the serial port.

]

‘Standard box’ is more flexible than ‘fast box’ but it takes lona
to display. However, it has superior anti-aliasing. can be &l
with a gradated colour and will precisely follow the angle of
text.

(‘ For most applications though, the ‘fast box’ will be found mors
than adequate.

|

&}
o

Boxi inel To box a single character ‘Point and Select’ the character first
oxXing a single then select “Box Text” from the Edit menu. This will display the
character Box Text menu shown in figure 3.18.

Adjust the width and height of the box by highlighting the
‘Oversize width” and ‘Oversize height’ headings and ente ering

the appropriate number of pixels and lines required. A number
of between 2 and 4 for both is more than adequate for most jobs.

Select the colour of the box by highlighting the ‘Colour number’
heading and entering the colour number. It helps to have the
Colour Palette on display at the time.
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Box text
Oversize width 0 pixels
Oversize height 0 pixels
0
Mode Character

Fast Box: Yes
Height Lock: Yes

Insert Boxes

Delete Boxes

Figure 3.18. The Box Text menu

Highlight the heading ‘Mode’ and operate the [SELECF] key
until the word “character” is displayed.

Select ‘Fast Box’ if you are not using a gradated colour fill and
your text is horizontal.

Select ‘Height Lock’ if you want the box height to match the
overall fount height.

Select ‘Insert Boxes’ toapply thebox tothecharacter. If your text
is hidden by the menus and you want to see if the box has been
applied correctly then operate the [SHIFT] key with the [CLEAR]
key to temporarily remove the menus from the edit display -
repeat to bring them back.

To box a single word ‘Point and Select’ the word first (any
character in the word will do), repeat the above instruction for a
single character except when selecting ‘Mode’ operate the
[SELECT] key until “Word” is displayed.
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Tobox arow onaword basis "Point and Select’ any character in
basi the row first, repeat the above instruction for a single character

asts except when selecting ‘Mode’ operate the [SELECT] key until
“Row - Broken” is displayed.

Boxing a row on a word

: 1 Repeat the above instruction for boxing a row on a word basis,
Boxing a complete row except select the mode “Row - full”.

Box delete works on a row basis only regardless of the tvpe of
Box Delete boxes displayed within the row.

To delete the boxes within a row, ‘point and select’ a character
within therow and select ‘Delete Boxes’ from within the Box Text
menu - see figure 3.18.

Please note: Edge, block and shadow attributes can be added to a box
using the ‘Shapes’ facility. Please refer to page 4.7 for details.
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Text Undetline

Existing text can be underlined using the Underline Text facility.
Text can be underlined on a character, individual word, row
word or full row basis. When an underline is added itautomati-
cally takes on the attributes (but not necessarily colour) of the
text above it.

(‘ Text can only be underlined after it has been entered.

Underlining a single
character

Underling a single
character

Underline text

Oversize width 0 pixels
Height 12 lines
Depth below base 15 lines
Colour number 10
Mode Character

Fast underline: Yes

Insert underlining
Delete underlining

Figure 3.19. The Underline Text menu

Like Boxing, there are two types of underline, namely 'standard
underline’ and 'fast underline' and the same rules apply. Please
read page 30 for further details.

To underline a single character, ‘Point and Select’ the character

first, then select 'Underline Text' from the Edit menu. This will
display the Underline Text menu shown in figure 3.19.
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Underlining a word

Underlining arow on a
word basis

Underlining a complete
row

Deleting the underline
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If necessary, adjust the width and height of the underime =
highlighting the ‘Oversize width’ and ‘Height’ headings a=c
entering the appropriate number of pixels and lines.

baseline by highlighting the ‘Depth below base’ heading anc
entering the appropriate number of TV lines.

Select the colour of the underline by highlighting the ‘Colour
number’ heading and entering the colour number. It helps &«
have the Colour Palette on display at the time.

Highlight the heading ‘Mode’ and operate the [SELECT] ksv
until the word 'Character’ is displayed.

Highlight the row headed 'Fast Underline’ and operate the
[SELECT] key if you want to switch fast underline on.

Select 'Insert Underline' to add the underline to the text. The
underline will be displayed beneath the text and the drop
shadow if the latter is present.

To underline a single word, first "Point and Select’ any character
in the word, then repeat as above except select 'Word' from
within the Underline Text menu.

To underline a row on a word basis ‘Point and Select’ anv
character in the row first, then repeat as above except select the
word 'Row-broken' from within the Underline Text menu.

Repeat the above instruction for underlining a row on a word
basis, except select the mode 'Row - full'.

To delete all the underlining in a row, first "Point and Select’ a
character in the row, then select 'Delete Underline' from within
the Underline Text menu.
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The dynamic functions that
follow are only available in
the Dynamic Display Plane.
The Static Display Plane, as
its name implies, can only be
used for static presentations.
See Chapter 4 for details.

L _J
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Dynamic Presentations

The rest of this chapter deals with dynamic presentations such
as rolls, crawls, zips, reveals and Vector special effects. Teach
File 2 contains several examples of each, but by far the quickest
way to master these is to have a go yourself so, after you've had
alookatthe examples in Teach File2 and read how we composed
them, create a new Page File for yourself and compose your own
dynamic presentations. You'll be surprised how easy it all is.

A few facts first

Teach File 2
page2to4d

Roll

Direction
Textcanroll up ordown thescreen, as well as over or under static
text and graphics in the other Display Plane. A roll can start
from a blank screen, or with stationary text on display.
Manual or auto start
You can start the roll manually, or have it start when you recall
the roll page from the disk memory, either instantly or after a
predetermined delay.

Smooth start and stop
A unique feature of Motif is its ability to accelerate and deceler-
ate smoothly.

Pause
You can instruct the roll to pause at any number of points by
adding pause markers as required.

Speed
Variable - you can adjust to almost any speed and all speeds are
smooth.
Timing
Timed rollis provided. Aftertherollhasbeencomposed youcan
enter the number of seconds you want it to run for. When
calculating the speed required, Motif takes into account any
pauses which may have been included and adjusts accordingly.
What ever speed of roll is required, movement remains smooth.
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Length
Althougharoll is identified by a single page number, it can be as
long or as short as you like.

Post editing
You can copy your roll and add and delete as much text as you
like.

Colour images
You can include logos, full colour images and background
shapes, but care should be exercised when running the roll. Do
not choose a speed which is too fast. It takes more time to
download large full colour images than it does ordinary text.

Our first roll example, which can be found on page 3 of TEACH
FILE 2, starts with a ‘parked’ or stationary yellow coloured
caption in the middle of the screen. The roll starts as soon as the
[START/STOP] key is operated and accelerates up to a speed of
1.2 lines per field.

As soon as the roll starts, the next block of text (coloured grey)
begins to appear at the bottom of the screen. This is followed by
a white block of text which slows down to a stop in the middle
of the screen. The roll waits for you to operate the [START/
STOP] key. The next block of text (blue) starts to decelerate to
a slower speed as it approaches the top of the screen. After a
couple of seconds the roll accelerates to a faster speed which is
maintained until the roll slows down to a final stop at the end.

Learn by example

) Step One. The Page was cleared, the founts and colours were
How the first roll was chosen and added to the fount and colour palettes, as necessary.
composed

Step Two. The opening caption (yellow) was entered in the
usual way.

Step Three. The Dynamic Page menu was selected from the
‘Dynamics’ menu and the [SELECT] key was operated until the
word ‘Roll” appeared in the box headed ‘Page Type’, see figure
3.20. Next, the [ACCEPT] key was operated to display the Roll
Setup Menu, as shown in figure 3.21.
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Dynamic Page

Vector Effect
(‘L Page Type: Roll
Page Sequence

Figure 3.20. The Dynamic Page menu

Roll Setup
Direction : Forward
Start Speed : 1.2 Lines/field
Timed Roll : 0.0 Seconds

Pause Type :  User Start
Pause Delay : 0.0

Fgure 3.21. The Roll Setup menu

Step Four. The Roll Setup menu was filled in by highlighting
each row in turn and entering the following:-

Direction: The [SELECT] key was operated until the word
‘Forward’ appeared.

Start speed: A speed of 1.2 lines per field was entered in the box.
Timed roll: This was left at zero.

Pause type: The [SELECT] key was operated until the words
"User Start’ appeared in the box.

Pause delay: This was left at zero because we wanted to start the
roll manually.

Finally, the [ACCEPT] key was operated. This placed the
character generator inits Roll Edit mode and, at the same time,
a "Top of the Roll’ marker, (see figure 3.22), was inserted in the
top left hand corner of the screen.
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Top of Roll Bottom of Roll
Marker Marker

Pause Marker E Timed Pause
(manual restart) Marker (auto restart)
Speed Up Slow Down

Marker Marker

Slow Down/ Slow Down/

Speed Up D Speed Up

'from' Marker 'to’ Marker
Figure 3.22. The Roll Markers

VE QR

Step Five. The cursor was moved down from the top left hand
corner, by one complete page, by operating the [SHIFT] key
with the Cursor Down key. This positioned the cursor on the
row that would ensure that the next block of text, coloured grey,
would appear at the bottom of the screen as soon as the roll was
started.

After we had typed in the grey block of text, we operated the
[RETURN] key ten times before typing in the next block of text
(white).

Step Six. After wehad entered all the blocks of text, we operated
the cursor up and down keys until the last line of the roll was
roughly in the middle of the screen, i.e. where we wanted it to be
when theroll came toastop. We thenheld downthe [SHIFT] kev
and operated the cursor home key.

Step Seven. We displayed the Edit Setup menu and selected
‘Edit Markers’. This displayed the Marker menu, as shown =
figure 3.23. We highlighted the row headed ‘Marker Type’ anc

[
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Marker

Marker Type: Bottom
Edit Marker

Delete Marker
Accept:

Inserts marker or modifies
Current marker

Figure 3.23. The Marker menu

operated the [SELECT] key until the word ‘Bottom’ appeared in
the box. We then operated the [ACCEPT] key. This placed the
Bottom marker next to the cursor. We now had a Top marker at
the start of the roll and a Bottom marker at the end.

Step Eight. Anempty page was selected (notdisplayed) and the
roll was stored.

Step Nine. The roll page was run a couple of times to check it.
At this stage, the roll contained no acceleration, deceleration,
speed change or pauses.

Step Ten. Acceleration and deceleration information, Pause
Markers and speed change markers, were next added as fol-
lows:-

The Cursor was moved up to the beginning of the roll. Then,
using the Trackerball, the arrow cursor was positioned over the
‘Top of the Roll” marker and selected by operating the [SELECT]
key. We then displayed the Top Marker Setup menu by operat-
ing the [CONTROL] key with the [E] key three times and
entered an acceleration distance of 80 TV lines.

We operated the [ACCEPT] key twice to display the Marker
menu shown in figure 3.23 and to add the acceleration rate of 80
TV lines to the “Top of the Roll” marker.
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Step Eleven. We moved the cursor down until the white block
of text was roughly in the middle of the screen and then operated
the [SHIFT] key with the Cursor Home key to position the cursor
in the top left hand corner of the screen. The Marker menu was
selected, therow headed ‘Marker Type’ was highlighted and the
[SELECT] key was operated until the word "Pause’ appeared in
the box.

Therow headed 'Edit Marker’ was highlighted nextand selected
todisplay the Pause Marker Setup menu as shownin figure 3.24.
The Pause Setup menu was filled in as follows:-

Lines to slow down: 150 was entered.

Pause Type: The [SELECT] key was operated until the word
‘User Start’ appeared in the box.

Pause Delay: zero seconds was entered.

Lines to speed up: 160 was entered.

Speed: 0.7 was entered as we wanted to decrease the speed
slightly.

After the Pause Marker menu had been filled in, the [ACCEPT]
key was operated twice to redisplay the Marker menu and to
insert the Pause Marker.

Step Twelve. Finally, using the techniques described in Step
Ten, the two Speed Change markers were added and the Roll

was stored.
Pause Marker Setup
Lines to slow down : 150 lines
Pause type :  User Start
Pause Delay : 00 Seconds
Lines to speed up : 160 lines
Speed : 07 lines/field

Figure 3.24. The Pause Marker Setup menu
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The second roll example

Selecting the Roll Edit

mode

C
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The second roll example on page 4 in TEACH FILE 2 is fairly
straightforward and can be used to try out some of the other roll
functions that are available, such as Timed Roll and Reverse
Roll. If you want to modify the roll examples, may we suggest
you make a copy of them first and modify the copies rather than
the originals. You can copy aroll by displaying it first and then
storing in an empty page.

Safe Area

D Roll starts to slow down when in line with
top of Safe Area

E Roll stops when in line with top of Safe Area

> Roll will have accelerated up to speed when
in line with top of Safe Area

Figure 3.25. Accelerate, Pause and Decelerate Markers

Modifying a Roll

Before aroll can be modified, the roll edit mode mustbe selected
using either one of the following two methods:-

Method 1. Wait until the roll finishes and then operate the cursor
up key.

Method 2. When the roll is running, operate the [SPEED] key
with the zero key in the numeric keypad.

After you've modified your roll, remember to resave it other-
wise all your changes will be lost.
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The Top of the Roll marker determines the start speed of the roll
its rate of acceleration and how the roll starts. A roll can star
automatically, either the instant it is recalled from disk or after z
number of seconds, or when the [START/STOP] key is oper-
ated.

Modifying the Top
Marker

Unlike the other markers, you don’t have to select the Top of the
Roll marker with the Arrow Cursor before making changes to it
All you do is select ‘Page type: Roll’ from the ‘Dynamics’ menu
and operate the [ACCEPT] key to display the Roll Setup menu
then operate the [ACCEPT] key again.

You can now change the acceleration rate of the Top of the Roll
marker. First display the Marker menu (Control + EE), highlight
the row headed ‘Marker Type’ and operate the [SELECT] kev
until the word ‘Top’ appears in the box. Then point and select
‘Edit Marker’ to display the Top Marker Setup menu. Enter the
number of TV lines over which you want the roll to accelerate.
Finally, operate the [ACCEPT] key twice.

All other markers have to be selected first before thev can be
modified, as follows. Place the arrow cursor over the marker,
operate the [SELECT] key and then operate the [CONTROL]
key with the [E] key twice. This will display the appropriate
Marker menu.

Before a marker can be moved it must be selected and the-.
deleted using the ‘Delete Marker’ function in the Marker menu,
see figure 3.23.

After the marker has been deleted, operate the [ACCEPT] key to
remove the ‘Edit’ menu. Using the Trackerball, position the
Arrow Cursor where you want the marker to be moved to, and
operate the [SELECT] key. Display the Marker menu (Ctrl E +E)
and press [ACCEPT] to insert the Marker.

Moving a Marker

. When editing a Roll, you can move up or down one complete
Page Scrolling page by holding down the [SHIFT] key when operating the
Cursor up and down keys.
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Timed Roll

After aroll has been composed and stored it can be instructed to
start and end within a specified time. This is done via the Roll
Setup menu as follows. Whilst in the Roll Edit mode, select
‘Page type: Roll’ from the ‘Dynamics’ menu and operate the
[ACCEPT] key.

This will display the Roll Setup menu as shown in figure 3.21.
Highlight the row headed ‘Timed Roll’ and enter the number of
seconds you wantbetween the startand end of the roll. Operate
the [ACCEPT] key and resave the page.

From now on the roll will run at a speed which ensures that the
bottom marker will arrive at the top of the Safe Area at the end
of the time specified.

Use the Timed Roll facility with caution. Always try your
‘Timed roll out before committing it to ‘air’. If the time selected
is too short for the length of the roll then the roll will ‘stutter’,
particularly when large full colour logos are included.

Reverse Roll

Normally a roll runs up the screen (forward), rather than down.
However, any roll can be made to roll down the screen as
follows. Whilst in the Roll Edit mode, select ‘Page type: Roll’
from the ‘Dynamics’ menu and operate the [ACCEPT] key.
This will display the Roll Setup menu. Highlight the row
headed 'Direction’ and operate the[SELECT] key until the word
‘Reverse’ appears in the box. Operate the [ACCEPT] key and
resave the page.

From now on the roll will run from top to bottom, starting with
the end of the roll.

This function can be selected before the roll is created.
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Speed change

Whilst arollis running its speed can be changed directly from the
keyboard. You have two choices. The first allows you to half,
quarter, double or quadruple the speed. The second allows you
to slowly accelerate or decelerate the roll. In other words one
provides a sudden change of speed and the other a smooth
transition.

Tohalf, quarter, double or quadruple the speed of a running roll,
press and hold down the [SPEED] key and operate the following
number keys in the numerical keypad-

Instant speed change

[1] = Quarter speed

[2] = Half speed

[3] = Double speed

[4] = Quadruple speed

(‘_ If you keep operating the number [1] key or hold the minus kev

down for too long the roll will eventually stop and the message
‘WAITING FOR START" will appear. When thishappens, press
and hold down the [SPEED] key and operate the number (4] kev,
release and then operate the [START/STOP] key. This will
restart the Roll, albeit at a very slow speed.

To slow down or speed up a running roll smoothly, press and
hold down the [SPEED] key with the ‘+" or -’ key in the
numerical keypad. Assoon as you release the keys the roll will
stop slowing down or speeding up and will continue at a steadv
speed.

Smooth speed change

If you select ‘Speed Zero’ whilst the roll is running, the roll will
stop and gointo its ‘Roll Edit’ mode. Itis therefore important to
avoid pressing the zero key when changing speed.
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Learn by example

How the first crawl
example was composed

Teach File 2
page5to8

Operating Manual

Crawl Captions

The facts we listed about Roll on page 3.35 apply equally to
Crawl. The markers used and the way in which they are entered
are the same, the only real difference being that Crawl markers
are entered along the top of the Safe Area, rather than up the left
hand side.

You will find two examples of Crawl in Teach File 2 on pages 6
and 7. This is how we composed the crawl in page 6.

Step One. The page was ‘cleared” and the opening caption was
entered in the usual way (Static Edit mode).

Step Two. The Dynamic Page menu, see figure 3.20, was
displayed (Control + D) and the [SELECT] key was operated
until the word ‘Craw]’ appeared in the box headed ‘Page Type’.
Next, the [ACCEPT] key was operated to display the Crawl
Setup menu, see figure 3.26 below.

Crawl Setup
Direction :  Forward
Start Speed : 2.0 pixels/field
Timed Crawl : 0.0 Seconds
Pause Type :  User Start
Pause Delay : 0.0

Fgure 3.26. The Crawl Setup menu

Step Three. The Crawl Setup menu was filled inby highlighting
each row in turn and entering the following:-

Direction: The [SELECT] key was operated until the word
‘Forward’ appeared in the box.
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Start Speed: A speed of 2 pixels per field was entered in the box
Timed Crawl: This was left at zero.

Pause Type: The [SELECT] key was operated until the worcs
‘User Start’ appeared in the box.

Pause Delay: This was left at zero because we wanted the craw.
to start the instant the [START/STOP] key is operated.

Finally the [ACCEPT] key was operated. This placed the char-
acter generator inits Crawl Edit mode and, at the same time, the
‘Left Hand’ marker was inserted in the top left hand corner of the
screen. See figure 3.27 below.

Step Five. The cursor was moved to the right in order to shi=
the opening caption left. When most of the opening caption had
moved off the left hand side of the screen we started tvping. As

moved to the left. Different text rows were set up by simp!s
moving the cursor up or down the screen and continuing to type
Different founts were selected and new ones processed, inciud-
ing the three MOTIF logos, whilst in the Crawl Edit mode.

Left Marker Right Marker (end
(start of Crawl) of Crawl)
Pause Marker Timed Pause

A

n (manual restart)
Speed Up

Marker

Slow Down/ Slow Down/
Speed Up Speed Up
'from’' Marker 'to' Marker

Marker (auto restart}

Slow Down
Marker

Figure 3.27. The Crawl Markers
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